Semester | Syllabus
FT-101C FUNDAMENTALS OF MANAGEMENT

Level of Knowledge:Working Knowledge

Course Objective:

* To help the students to understand the functiodsesponsibilities of the managers.
* To provide tools and techniques to be used in énopmance of managerial job.
* To enable students to analyze and understand th®ement of the organization.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

External exam will have 2 Sections A and B. Sec#oworth 36 marks will consist of 5 theory
guestions, out of which students will be requiredattempt any 3 questions. Section B worth 24
marks will comprise of 3 questions of an Analyti¢@ase let/Research Situation)/Practical nature
of which students will be required to attempt anyu2stions. A question can have one or more sub-
parts.

Course Contents:
Unit 1: Concept of Management:

» Definition of management

 Management functions (planning, organizing, statfindirecting, coordinating,
controlling)

* Management & Administration

* Nature of management (management as art, sciedgerafession)

* Roles of managers

» Evolution of management thoughts

» The scientific management school (Taylor)

» The management process school (Fayol’s Princigl®&anagement)

* Bureaucracy theory school

» Developing excellent managers.

Suggested Cases:

1. BHEL (L M Prasad)

2. Image is Everything (Stephen P Robins & Mary Calilte
Unit 2: Planning:

* Nature and purpose of planning, Principles of pilagn
* The planning process, Types of planning
* Advantages and limitations of planning.



Suggested Cases:

1. Westward Exports Ltd (R S Raju & A Parthasarathy)
2. MTV’s World (Stephen P Robins & Mary Coulter)

Unit 3 : Concept of Objectives:

» Types of objectives, Importance of objectives, iBgtbbjectives
* Management by Objectives (MBO), Benefits and Weakas of MBO.

Suggested Cases:
Municipal Water District (Harold Koontz and HeiWgeihrich)

Unit 4: Strategies and Policies:

» Concepts of corporate strategies- Vision, Miss{@bjectives

» Strategic planning process

» Brief introduction to SWOT analysis, TOWS matrixgrifolio matrix- GE matrix, BCG
matrix

» Porter’s generic strategies

» Types of policies, Principles of formulation of s

» Decision making process, Individual decision makimadels

Suggested Cases:

1. Turbulent Flight Plan (Stephen P Robins & Mary Gen)l
2. McDonald's- Serving Fast Food Around the World @fiiKoontz and Heinz Weihrich)

Unit 5: Organizing and staffing:

* Nature and Purpose of organizing

* Bases of Departmentation

» Span of Management, Determinants of Span of Managem
* Line and staff relationships, Line-staff conflicts

» Brief introduction to Mintzberg Organization

» Bases of Delegation, Kinds of Delegation, Delegatiad Decentralization, Methods of
Decentralization

» Definition of staffing, Factors affecting staffinBecruitment and Selection.
Suggested Cases:

1. Major Tools Ltd (R S Raju & A Parthasarathy)

2. Competitive Challenges for Carmakers (Harold Ko@md Heinz Weihrich)
Unit 6: Directing:

» Principles of Directing, Problems in Human RelasiopiNature and causes of Human
Relation Problems

» Strategies for establishing healthy Human relatioren organization
Suggested Cases:

1. Belden Electronics Company (Harold Koontz and HéMeihrich)
2. Ram Dhin (R S Raju & A Parthasarathy)



Unit 7: Controlling:

* Concept and Process of Control, Control Techniqutsmnan Aspects of Control,
Control as a feedback system, Feedforward corRrelyentive control
» Use of Computers for controlling and Decision mgkin

Suggested Cases:

1. The Kappa Corporation (Harold Koontz and Heinz \elt)
2. Mehta Bank Ltd (R S Raju & A Parthasarathy)

Text Readings:

1. R D Agrawal, Organization and Management, New Ddlhta McGraw Hill, 1990.

2. Harold Koontz and Heinz Weihrich, Essentials of agement, McGraw Hill, B
edition.

3. T N Chhabra, Principle and Practice of managenigimnpat Rai & Sons.

Suggested Readings:

1. Stephen P Robins and Mary Coulter, ManagementsBeaublications, "7 edition.

2. L.M. Prasad, Principles & Practice of ManagemenClsand & Sons, 2005

3. Robert Krietner, Management, New Delhi, AITBS Pshiirs and Distributors,™7
edition



FT-102C QUANTITATIVE TECHNIQUES

Level of Knowledge:Working Knowledge.

Objective:
 To develop conceptual understanding of fundamerdélguantitative and statistical
methods
 To develop the understanding of its applicationsmanagement with the help of
examples.

Scheme of Examination:

Total Marks: 100
Internal Evaluation: 40
External Evaluation: 60

External examination will have 8 questions, outMbiich a student has to attempt any five. Each
guestion will carry equal marks. A question canehawne or more sub-parts which may contain
theoretical and/or practical problems.

Course Contents:
Unit 1: Sets and Functions:

» Definition, representation of sets, types of sSéemn diagrams, cardinal number of a set,
subsets, universal set, operations on sets (Umbersection, Difference, Symmetrical
difference), complement of a set, disjoint setxpprties of union and intersection
(Closure, Associative, Commutative, Identity, Imsesr Distributive Law and
Demorgan’s Law), applications of sets operationsoiwing business problems.

* Ordered pairs and Cartesian product of sets, RRefatDomain and range of relation,
Types of relation

 Mapping and function, definition and its types (a@me, many-one, onto, into,
invertible, even and odd, monotonic, continuousscalntinuous, algebraic and
transcendental), some common functions with theoperties and graphs (Linear,
guadratic, exponential, logarithmic, modulus), Castction, Revenue function, Profit
Function and break even analysis, practical problem

Unit 2: Sequences and Series:

* Introduction to Arithmetic, Geometric and HarmoRi®gressions
* Nth term, No of terms, Sum of n terms, AM,GM and HMumerical problems
» Discounting, Compounding and Annuity along with Nwemerical problems.

Unit 3: Matrices:

» Definition, Types of matrices

» Operations on matrices (addition, subtraction anttiplication)

» Transpose of a matrix, Determinant of matrix, Adnjoof a matrix, Inverse of a
matrix, Elementary row operations.

» Solutions of simultaneous linear equations usingioes (Cramer’s Rule,
Matrix Inverse Method)

* Numerical and practical problems.



Unit 4: Introduction to Statistics:

* Meaning and Definition of Statistics, Scope and itatons of Statistics, Role of
Statistics in Management Decisions

» Primary and secondary data, method of data cadlectilassification and tabulation of
data, frequency distribution, diagrammatic and DQregd representation of data (Bar
diagram, Pie diagrams, histogram, frequency poly@mives)

* Measurement of Central Tendency (AM: simple, wesghtind combined for discrete
and continuous series, Introduction to GM and HMedMn, Quartiles, Deciles,
Percentiles and Mode of Discrete and Continuousseipractical problems

» Measurement of Dispersion (Range, Interquartile ge&Quartile deviation, Mean
deviation, Standard Deviation, Variance, CoeffitiehVariation), Practical Problems.

Unit 5: Correlation & Regression:

» Correlation (Karl Pearson’s and Spearman’s Coeffipi

* Probable error, Standard error and coefficientat&édmination

» Principle of Least squares, regression coefficigRégression lines and equations.
» Fitting of second degree parabola, Practical proble

Unit 6: Time Series:

» Time Series and its Components and Analysis MoafelSme Series

* Methods of Studying Components of Time Series

 Measurement of trend (moving average, exponentmabdhing and least squares
method). Practical problems.

Unit 7: Probability Theory:

* Introduction, Experiment, Trails and events (exhi&as mutually exclusive, dependent
and independent), Sample space, Favorable and arafale events.

* Odds, Calculation of probability, Theorem of proitigp(addition and multiplication)

» Conditional Probability, Baye's Theorem, MathemaiticExpectations, Practical
Problems

» Basic concepts of Binomial, Poisson and Normalriistion.

Text Readings:

1. Sharma, J. K., Mathematics for Management and CtenpApplications, New Delhi:
Galgotia Publication, 2008.
2. Gupta, S. P., Statistical Methods, New Delhi: Sulfdand and Sons, 8%&dition, 2007.

Suggested Readings:

1. Ghosh, R. K. and Saha, S., Business MathematicStaittics, Kolkata: New Central
Book Agency, 2000

2. Goel, Ajay and Goel Alka, Mathematics and Statsstillew Delhi: Taxman Allied
Services, 2007

3. Sancheti, D.C. and Kapoor, V.K., Statistics: Thebtgthods and Applications, New
Delhi: Sultan Chand and Sons, 2001



FT-103C ACCOUNTING FOR MANAGERS

Level of Knowledge:Working Knowledge.

Course Objectives:

* To Lay a conceptual framework for financial accaonmt Cost Accounting and
Management accounting.
» To develop ability in the students to apply theioedtconcepts in practical life problems.

Scheme of Examination:

Total Marks 100
Internal Marks 40
External Marks 60

Section A: 24 Marks comprising three theory questions outvbich student will be required to
attempt any two questions.

Section B: 36 Marks comprising four practical problems outwdfich student will be require to
attempt any three questions.

Course Contents:

Unit 1: Introduction to Accounting:

* Meaning & Need of Accounting
» Generally Accepted Accounting Principles (GAAP)

» Concepts of Accounting:
Going Concern

Entity Concept

Historical Cost

Money Measurement
Accounting Period Concept
Matching Cost Concept
Accrual Concept

YVVVYVVVY

» Conventions of Accounting:
» Conservatism
» Consistency
» Materiality

» Concepts of Double Entry System Of Accounting

* Rules for Debit and Credit Entries ,Types Of Acdsun
» Nominal
> Real
» Personal

» Distinction between Capital and Revenue Expenditure

Unit 2: Elements of Annual Accounts:

» Defining & Understanding the Terms Share Capital
* Reserves

* Surplus

* Shares



Share Premium

Loan Funds

Debentures

Bonds

Mortgage Loans

Secured Loans

Unsecured Loans

Current Liabilities & Provisions
Contingent Liabilities

Fixed Assets, Leased Assets
Current Assets, Advances
Investments, Deferred Revenue Expenses Instrurikat€heque and its Types
Demand Drafts/Pay Order
Crossing Etc.

Unit 3: Accounting Procedures:

Recording of Journal Entries
Posting In Ledger Accounts

Cash Book:

» Single Column
» Double Columns
» Three Columns

Concepts and Preparation of Subsidiary Books:
> Purchase and Purchase return/outward books
» Sales and Sales return/outward book

Preparation of Trial Balance

Unit 4: Preparation of Final Accounts:

Profit and Loss Account
Profit and Loss Appropriation Account

Preparation of Balance Sheet with Basic Adjustments
Prepaid Expenses

Outstanding Expenses

Provisions for Doubtful Debts

Accrued Income

Income Accrued but not Due

Depreciation, Closing Stock

YVVVYVYVY

Conceptual Knowledge and Final Accounts of Non iPMé&king Organizations

Unit 5: Bank Reconciliation Statement.



Unit 6: Depreciation:

» Concepts of Depreciation
* Two Methods of Providing Depreciation WDV and SLM
» Simple Practical Problems Relating to Depreciation

Unit 7: Introduction to Cost and Management Accounting:

* Nature, Role, Scope, Concepts of Cost Centers astdhits

» Classification of Cost

» By Nature: Material, Labour and Overheads

» By Behavior: Fixed Costs, Semi-Variable Costs aadable Costs

» Concepts and Distinction between:
» Marginal and Absorption Costing
» Period and Product Cost
» Cost Reduction and Cost Control

» Concept of Total Cost.

Unit 8: Standard Costing:

» Standard Costing and Variance Analysis Concep&aridard Costing,
» Concepts of Variances

e Calculation of :

» Material Variances:
o Material Cost Variance
o0 Material Price and
o Material Usage variance
o0 Material Mix Variance

» Labour Variances:
0 Labour Cost Variance
0 Labour rate Variance
0 Labour Efficiency Variance
o0 Labour Idle Time Variance
o Labour Yield variance

» Overheads Variances:

Total Overheads Cost Variance

Fixed Overheads Cost Variance

Variable Overheads Cost Variance
Variable Overheads Efficiency Variance
Variable Overheads Expenditure Variance
Fixed Overheads Volume Variance

Fixed Overheads Expenditure Variance

O O0OO0OO0OO0OO0OOo

Unit 9: Decision Making:

» Cost Analysis for Decision Making, Make or Buy daons, Accept and Reject
Decisions.
» Simple Problems Based thereon.



Text Readings:

1. R.L. Gupta, V.K. Gupta, Principles of Accountanbigw Delhi,Sultan Chand and Sons.

2. S.N Maheshwari, Introduction to Accounting, New mgVikas Publishing House

3. S.N Maheshwari, Cost Accounting, Theory and ProBl&law Delhi, Vikas Publishing
House.

Suggested Readings:

1. S.P lyengar, Cost Accounting , New Delhi,Sultan i@hand Sons.
2. Gupta Radha Swami, New Delhi,Sultan Chand and Sons.
3. Hanif Mukhargee, Modern Accountancy, Tata McGraw. Hi



FT-104C: IT Fundamentals

Level of Knowledge:Working Knowledge.

Course Objectives:

» To provide basic knowledge about the computer foretdals.
* To develop conceptual understanding of MS-Office Brternet.

Scheme of Examination:

Total Marks: 100

Internal Marks: 20
External Marks: 60
Practical Marks: 20

There will be an internal assessment of 20 markksexternal examination of 60 marks. External
examinations will have 8 questions out of whichwdent has to attempt any five questions. Each
guestion will carry equal marks.

Course Contents:
Unit 1: Computer Fundamentals:

* Introduction to Computer:
» Characteristics
» Block Diagram

» Parts of Computer:
» Processor
» Input/Output Devices
» Primary and Secondary Memory

» Types of Computers:
» Micros
» Mini
» Mainframe
» Super Computer

* Level of Languages:
» High and Low Languages
» Their characteristics

» Software:
» System Software (complier, Interpreter, Assembter @perating system)
» Application Software

Unit 2: Operating System:

* Introduction of Operating System:
» Features
» Types of Operating System

*  Windows XP:
» Using Taskbar

10



Start Menu options
My Computer
Recycle Bin

My Network Place
My Documents

S VVVVY

indows Accessories:
Calculator
Note Pad
Word Pad
Paint
Entertainment
Address Book

ontrol Panel:
Installation of Software
Addition of new hardware
Installation of Modem
Sound card
Printers and Scanner
Date and time
Taskbar and Start Menu

VVVVVVVQO VVVVYVYY

* Windows Explorer:
» Creating a new folder and other explorer facilities
» Changing the look and feel of windows (Desktop, &ger, Screen saver etc.)

Unit 3: Application Software-1 (MS-Word 2003 and MS-Excel 2003):
+ MS-WORD:

» Getting Started with MS-Word
» Document Creation
» Document Manipulation
» Printing a word document
» Header and Footer

* Table Handling:
> Inserting
» Filling and Formatting a table

» Finding Replacing and Proofing text:
» Spell check
» Grammar check
» Find and Replace
» Creating Macros
» Mail-Merge

 MS-EXCEL:

* Introduction to MS-Excel:
» Application of Electronic Spreadsheet
» Features, Starting MS-Excel
» What is a Workbook
» Entering Data, Entering Series



Unit 4:

» Editing Data, Saving a workbook
» Closing a workbook
» Quitting MS-Excel

» Cell Referencing, Ranges and Functions
» Cell referencing
» Ranges
» Ranges names

» Formulae (names in a formula, formula editing, dogy formula)
Functions(Mathematical and Statistical)
» Formatting Worksheet and Creating Charts
» Formatting Data
» Creating charts
» Graphical presentations such as line, bar, stacégdie

* Printing Excel Sheet
* Creating Macros

Application Software-Il (MS-PowerPoint 2003and MS-Outlook):

« MS-PowerPoint

e Starting MS-PowerPoint:
Creating a presentation
Creating new slides
Layout of slides
Deleting a slide
Running a slide show
Saving a Presentation

orking With Slides:
Changing the order of the slides
Editing the slide master
Changing the background
Adding a text
Clip Art
Scanned objects and Image
Drawing Objects
Controlling the Slide Show(Animation, Transitiorpe®ial effect, Slide timing)
Printing a Presentation

VVVVVVVVVS VVVVVY

e MS-Outlook:

* Working with Outlook:
» Address book (add contact, find contact, sortiitiggring)
» Changing View
» Calendar
» Managing task

* Email With outlook:
» Configuring outlook for mail
» Sending and Receiving of Mails
» Saving mails

12



» Mail Format
» Mail Setup
» Signature

Unit 5: Internet Basics:

* Concepts and Services

» Hardware and Software requirements
* Type of Internet connections

» Advantages and Disadvantages of Internet
« WWW

 E-malil

* Browsers

» Search Engines

* Internet Addressing

e Domain Name

« URL

* Protocols (TCP/IP, FTP, HTTP)

» Overview of Intranet and Extranet

» Video conferencing

* Overview of HTML.

Text Readings:

1. Sinha P.K., Computer Fundamentals New Delhi : BRBliPations, Third Edition,2001

2. Saxena Sanjay, First Course in Computers New Délkas Publishing House,2003

3. Leon Alexis and Methews Leon,Internet for Every@iesnnai:Leon Press and Vikas
Publishing House, 1999

4. Microsoft windows XP STEP BY STEP - PHI

Suggested Readings:

1. Jaiswal S., Information Technology Today, New Dellbalgotia Publications
Pvt.Ltd.,2001.
2. Christian Crumlish, ABCs of the Internet, New DeBPB Publications,1998

13



FT-105C BUSINESS AND ECONOMIC ENVIRONMENT

Level of Knowledge:Working Knowledge.

Course Objective:

* To familiarize the students with the business emnment prevailing in India and
globally.
* To understand its implications to business.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsctia A will carry 36 Marks Comprising 5
Theory questions out of which a student will beuiegg to attempt any three questions. Section B
will carry 24 Marks comprising of one or more Cade(

A question can have one or more sub-parts.

Course Contents:
Unit 1: Business Environment:

* Components

» Significance Economic Scope

* Cultural

» Political and Technological factors.

» External Factors Influencing Business Environment
» Dimensions of International Business Environment
* Challenges.

Suggested Case:

Technology implementation for Card based businessse of Deutsche Bank, Italy

Unit 2: Economic Planning & Development:

» Economic systems-Economic planning with speciadrezice to last three plans, public,
private joint and cooperative sectors

* Industrial Policy of the Government — Policy Resiolins of 1956, 1991 Industrial Policy
and Economic Policy — Subsequent policy Statements.

Unit 3: Indian Companies:

» Competitiveness

* Changes

* Challenges

» Sustainable Development.

» Emerging Trend in Indian Business Environment.

14



Unit 4: International Trade Theories:

* Balance of Payments

» Concepts

» Disequilibrium in BOP

* Methods of Correction

» Trade Barriers and Trade Strategy

* Free Trade vs. Protection

* World Financial Environment: Foreign Exchange Mamlechanism
» Exchange Rate Determination and Euro Currency.

Suggested Case:
Where is the fair play

Unit 5: Strategies for Going Global:

* International Economic Integration

* Country Evaluation and Selection

* Foreign Market Entry Method

» International Trading Blocks and their Objectives.

*  WTO- Origin, Objectives, Organization Structure &nhctioning
* WTO and India.

Suggested Case:
Different for gamble

Unit 6: Theory of Demand, Firms & Market Structure:

 Demand function

* Income and substitution effects
* Revealed preference approach
 Demand forecast.

* Profit Maximization

» Sales Maximization

» Organizational slack

* Ownership and Control.

» Competition

* Monopoly
* Duopoly
» Oligopoly

* Non-Price Competition.
Suggested Case:
Country wide venture.

Text Readings:

1. Francis Cherunilam, Business Environment: Text &&aNew Delhi, HPH, 2007.

2. D.N. Dwivedi, Managerial Economics, Vikas Publighidouse, 2007.

3. Justin Paul, Business Environment: Text & Casesy Nelhi, Tata McGraw Hill, 2008
4. Aswathappa, Essentials of business environmentaldya Publications.
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5. M.L jhingan, Micro economics, Vrinda publications
6. H.L Ahuja, Priciples of micro economics.

Suggested Readings:

K.V. Sivayya and VBM Das: Indian Industrial Econon8ultan Chand Publishers, Delhi.
Avid W. Conklin, Cases in Environment of BusineSage Response Books.

Vivek Mittal, Business Environment, Exdcel, ND.

Sundaram & Black : International Business Environtrieext and Cases, PHI.

Raj Agarwal : Business Environment, Excel Publmagi

E. Bhattacharya: International Business, Excel ieatibns.

Gouvt. of India, Latest Economic Survey.

NoohswbhPE
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FT-106C: ORGANIZATIONAL BEHAVIOR

Level of Knowledge:Working Knowledge.

Course Objective:

 To understand human behavior in organizations ideorto improve managerial
effectiveness.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsctia A will carry 36 Marks Comprising 5
Theory questions out of which a student will beuieggd to attempt anthree questions. Section B
will carry 24 Marks comprising of one or more Cade(

A question can have one or more sub-parts.

Course Contents:

Unit 1: Foundations of Individual & Organizational Behavior:

* Introduction to OB & Basic OB Model.

» Personality-Determinants & Attributes, The Big FMedel.

» Attitude-Components, Job Attitude

» Learning-Theories of Learning.

» Perception-Factors affecting Perception, Cognithasonance Theory.

Suggested Cases/s:
1. Prejudice in work places: Real or Perceived? (Kvdthappa)
2. Breakout Performer (Azim Premiji) (K. Aswathappa)

Unit 2: Motivation:

* Concept
* Definition
e Theories:

» Maslow’s Hierarchy of Needs

» Herzberg's Two Factors

» Theory X and Y. Vroom’s Expectancy
» Reinforcement Theory.

Suggested Casel/s:
1. Jinjian Garment Factory: Motivating Go slow workdr§&erard H. Seijts).
2. When the Perks Fade (Stephen P. Robbins and Sesrgais

Unit 3: Groups and Teams:

» Defining and Classifying groups.
» Stages of Group Development
* Group Structure

17



* Group v/s Team
* Types of Teams

Suggested Casel/s:

1. Groups make a difference at Brazil's Semco (K. Astinappa)
2. Avirtual team at Nanawati Associates. (StepheRdhbins and Seema Sanghi)

Unit 4: Leadership:

» Definition and Concepts.

» Trait Theory

* Behavioural Theories-Ohio State, Michigan Studi¢éanagerial Grid.

» Contingency Theories-Fiedlers Model , Hersey & mlhard’s Situational Theory,

Leader Member Exchange Theory, Path Goal theory.

Suggested Case/s:

1. GE’s Controversial Leader (K. Ashwathappa)
2. Narayan Murthy & Infosys (Stephen P. Robbins aneh@eSanghi).

Unit 5: Conflict:

» Defining

* Types of Conflict

» Conflict Process.

» Conflict Management Techniques.

Suggested Casel/s:

1. Escalation of conflict through Endowed Chair ( UB&karan)
2. Schneider Nation(Stephen P. Robbins and Seema $angh

Unit 6: Organization Culture:

» Defining

» Creating and Sustaining Culture

» Creating an Ethical Organizational Culture.
» Creating a positive Organizational Culture.
» How Employees learn Culture.

Suggested Case/s:

1. Cultural Change efforts at the U.S. Postal Servi&ephen P. Robbins and Seema
Sanghi)
2. South west airlines faces new challenges. (Steph&wobbins and Seema Sanghi)

Unit 7: Organization Change & Stress Management:

» Forces of Change, Resistance to Change
* Lewin’s Three Step Model
» Stress —Potential Sources, Managing Stress.

18



Suggested Case/s:
1. Case of ABB Poland, (Gerard H. Seijts).
2. A dark day.(Stephen P. Robbins and Seema Sanghi)

Text Readings:

1. Stephen P. Robbins & Timothy A. Judd@®rganizational Behaviour, 13" ED., New
Delhi, Prentice Hall.

2. K. AswathappaQrganizational Behaviour, Himalaya Publishing House, Mumbai.
3. Fred LuthansQrganizational Behaviour, McGaw Hill, New York.

Suggested Readings:

1. Gerard H. SeijtsCases in Organization BehaviourSage Publication, New Delhi.

2. John W. Newstorm & Keith Davi€rganization Behaviour, Tata McGraw Hill, New
Delhi.
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FT -107C BUSINESS COMMUNICATION

Level of Knowledge:Working Knowledge

Course Objective:

* To familiarize the students with the fundamentdilbusiness communication

* To develop the conceptual understanding by grasghiegelementary and the general
concepts

» To substantiate a theoretical knowledge by pradticawledge of the subject

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

The External Examination will have Two Sectionsctia A will carry 36 Marks Comprising 5
Theory questions out of which a student will beuieggd to attempt anthree questions. Section B
will carry 24 Marks comprising of one or more Cade(

A question can have one or more sub-parts.

Course Contents:
Unit 1: Introduction:

» Defining Communication

* Process of Communication

» Communication Situation

* Communication Models

» Objectives of Communication

» Principles of Effective Communication

* Importance of Business Communication
* Importance of Feedback

Suggested Case:
Arvind Pandey caught in Business Web

Unit 2: Factors affecting Communication:

» Barriers to Communication
» Wrong Choice of Medium
» Physical Barriers
» Different comprehension of Reality
» Socio-Psychological Barriers

» Effective Listening:
» Steps of Listening
» Importance of Listening
» Blocks to Effective Listening
» Improving Listening Skills

Suggested Case:
Communication Failure
20



Unit 3: Types, Channels and Forms of Communication:

* Formal and Informal Communication

* Upward Communication (Objectives, Merits and Detsgri

* Downward Communication (Objectives, Merits and Deatae
* Horizontal Communication, Grapevine,

» Consensus (Process, Advantages, Disadvantages)

* Verbal Communication, Nonverbal Communication

Suggested Case:
Wave (ATV: Advertising Radio FM Band)

Unit 4: Designing for Effective Communication:

» Understanding the composition Process
» Defining the purpose

* Analyzing the audience

» Establishing the main idea

» Transaction Analysis

Suggested Case:
The Case for Ambiguous Communication

Unit 5: Fundamentals of Business writing:

» Adaptation and Selection of Words

» Construction of clear sentences and paragraphs

» Directness in Good News Letter and Neutral Situnatio
* Indirectness in Bad News Letter

* Persuasive Messages

Suggested Case:
On Writing Well

Unit 6: Employment Messages:

* Application Letters

* Writing the Opening Paragraph,

» Summarizing the key Selling Points

* Writing the closing paragraph

» Writing a perfect Resume - Format, Style, Contents

Unit 7: Reports and Proposals:

* What is a Report?

* Importance of a Report

» Oral and Written Reports

» Types of Business Reports

» Characteristics of a Good Report
* Sample Reports



Unit 8: Negotiation Skills:

* Negotiation Skills:

* What is Negotiation?

* Nature of Negotiation

* Need to Negotiate

» Factors affecting Negotiation

» Spoken English

* Presentations

» Group Discussions
* Public Speaking

Text Teadings:

1. Rajendra Pal and J.S. Korlahalli, Essentials ofifg&2es Communication, Sultan Chand

and sons 2005.
2. Urmila Rai and S.M. Rai Business Communication mélaya Publication House ll/e

2001
3. P.D. Chaturvedi and Mukesh Chaturvedi ,Businessncomication : concepts, cases

and applications ,Pearson Education 2004

Suggested Readings:

1. Effective Business Communication- M.V. Rodrigu€oncept Publishing Company,
New Delhi

2. Business correspondence and Report Writingk. IR@&. Sharma and Krishna Mohan,
Tata McGraw Hill & Co. Ltd., New Delhi
Bill Scott, The Skills of Communication, Boa Jaico, 1995

3. William V. Ruch, Business Communication, New Y okkaxwell Macmillian, 1991
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FT-108 C OPERATIONS MANAGEMENT

Level of Knowledge:Working Knowledge.

Course Objectives:

* To help students understand the concepts of mhteaaagement, operation functions,
various tools used for solving problems faced bgrapons managers.

Scheme of Examination:

Total Marks: 100
Internal Marks: 40
External Marks: 60

External examination will have 8 questions, outvbich a students has to attempt any five. In the
external examination, there will be two sectionsad B. Section A, worth 24 marks, will consist
of four theory questions out of which a studentl wi¢ required to attempt any two questions.
Section B, worth 36 marks, will have five numeripabblem(s)/ practical problem(s), out of which
a student will be required to attempt any threestjoes. Each question will carry equal marks. A
guestion can have one or more sub-parts

Course Contents:
Unit 1: Materials Management:

* Meaning, Definition, Areas, Objectives, Importance,

* Role of Materials Manager.

* Meaning, Concept, need, Scope and Advantagesegrited Materials management.
» Factors affecting Materials planning, Techniqueplahning.

* Materials Budgeting.

Unit 2: Stores Management:

» Materials Identification:
» Need
» Importance
» Classification of Materials.

* Codification of Materials:
» Caodification Systems

* Standardization:
» Aims and Advantages
» Standards of Institutions

» Stores Layout

» Materials Handling:
» Unit Load Concept
» Materials Handling Principles
» Material Handling Equipments (Fixed path, varigiéeh and auxiliary)

Unit 3: Inventory Management:

* Importance and scope
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» Selective Inventory Control
» Cost concept in Inventory
» Types of Inventories Problems

* Inventory Control Models:
» Deterministic and Stochastic (EOQ, EBQ, EOQ witbrthges, EOQ with discounts,
Single Period Model, Periodic Model)
> Practical Problems.

Unit 4: Introduction to Operations Management (OM):

* Meaning and functions of OM

* Current trends in OM

* OM manufacturing and service industries
* Issues of OM (short-term and long-term)
» Challenges faced by OM

* Priorities of OM.

Unit 5: Facility Planning:

* Product and Process selection:

Product development process

Tools of efficient product development

Determinants of process characteristics (volumeaetaand flow)

Types of process systems (continuous flow, inteéemitflow and jumbled flow)
Product-Process mix

Issues in process design

Technology selection.

YVVVYVVVY

* Layout of facility:
» Product
» Process
» Fixed group
> Project layouts

* Layout design:
» Relationship based and Load-Distance-Cost matrix
» CRAFT method
» Practical problems

» Location of facility:

Factors affecting location decisions

Center of Gravity and Median Models
Dimensional Analysis, Factor rating method
Brown and Gibson Model

Practical Problems

YVVVVY

Unit 6: Resource Planning:

» Capacity Planning:
» Meaning of Capacity and Capacity Utilization
» Capacity planning framework
» Machine and Labour requirement estimations
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Capacity Augmentation, Alternatives of Capacity Aentation (waste elimination,
Multi-skilling of work force, sub-contracting anditsourcing)

Practical Problems

Learning-Curve applications

Practical Problems.

YVVV VYV

Materials Requirement Planning (MRP):

Introduction

Multiple levels in Products

Product Structure

Bill of Materials.

Rules for determining Lot Size (Lot-for-lot, Fixedder quantity, EOQ, Period order
guantity, POQ based on EOQ)

» Practical Problems.

YVVVVY

Unit 7: Production Planning and Control:

Aggregate Production Planning:

» Necessity and framework

» Alternatives of managing demand and supply

» Level Production (Inventory Cost and Stock-Out Cost
» Chase (Vary the Work Force) and mixed strategies

» Practical Problems

Operation Scheduling and production control:

» Mass manufacturing (Assembly line balancing usingrity rules- Rank Positional
Weight, Longest Activity Duration and Largest Numbé Successors)

Batch Processing (Sequencing using Run-Out Timeé)Jab Shop :

n - job on single machine (using EDD, SPT, FCFS,&R)
n-jobs on two/three machines (Jhonson’s Rule, Gaimdirt)
2 jobs on n-machines (Graphical Method-Aker’s Aitjon)
Practical Problems

YVVY

Text Readings:

1.
2.

3.

4.

Verma M.M, Materials Management, New Delhi, Sul@mand and Sons.

Chitale, A. K. and Gupta R.C., Materials Managem&ekt and Cases, New Delhi: PHI,
2006.

Paneerselvam, R., Production and Operations Marageidew Delhi, Prentice Hall of
India Publications.

Mahadevan,B., Operations Management Theory andi€rablew Delhi, Pearson
Education (Dorling Kindersley (India) Pvt. Ltd.)

Suggested Readings:

1.

2.

3.

Chary, S.N., Cases and Problems in Production gestafions Management, New
Delhi, Tata McGraw Hill Publications.

Evans, J. R., Anderson, David R., Sweeney, D.d Vditliams, T.A., Applied
Production and Operations Management, Newyork: \Wabtishing Co., 1985.
Dobler Donald W., Lamer Lee Jr. and David N. BBdychasing and Materials
Management, New Delhi, Tata McGraw Hill Publicason
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